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Einführung 
 
Willkommen zu Amberlight 2! 
 
Amberlight ist ein einzigartiges Kunstwerkzeug, welches wunderschöne computergenerierte 
Bilder und Animationen kreiert. Ein Millionen von Teilchen fliegen durch Ihre Szene und man 
kann sie mit den speziellen Amber Felder steuern. Egal, ob Sie ein erfahrener Künstler oder ein 
kompletter Kunstanfänger sind, mit dem Spielen und Experimentieren mit diesem Werkzeug 
können Sie fantastische Bilder und Motion Graphics erstellen. In der Welt der Computerkunst ist 
es ein one-of-a-kind Werkzeug, welches Ihren künstlerischen Horizont erweitert und ein ganz 
neues Kunsterlebnis bietet. 
 

Amberlight 2 wird mit vielen innovativen Features wie fortgeschrittenem Animationsmodus, 
Modifikatoren und Variationen verstärkt. Von nun an können die Benutzer das Leben in ihre 
Kunstwerke einatmen und makellose Animationen erzeugen, die als das Video oder 
Bildsequenzen gespeichert sind. 
 
Ähnlich wie beim Flame Painter, Amberlight wurde ursprünglich als ein Experimentierprojekt in 
meiner Serie "I am an Artist” entwickelt. Meine erste Vision sollte ein Programm sein wo jeder 
etwas Schönes gestalten konnte. Es sollte ein Werkzeug sowohl für den Künstler als auch für 
Leute ohne künstlerisches Talent sein, die was Einzigartiges gestalten wollen. 
Der Mangel an Inspiration ist oft der Grund warum Menschen nicht kreativ sind, jedoch können 
die Werkzeuge die wir nutzen eine Quelle der Inspiration sein. Mit jedem Werkzeug, das einen 
inspiriert, kann jeder zum Künstler werden.  
 
Dieses Manual umfasst die Funktionen und Anwendung des Programms und erklärt Ihnen was 
Sie wissen müssen, um Amberlight zu verwenden und wie eine ganz neue kreative Art und 
Weise der Selbstdarstellung zu finden. 
 
Danke, dass Sie Amberlight erworben haben. Wir hoffen Sie haben viel Spaß damit! 
 
 
              Peter Blaškovič 
         Entwickler von Amberlight  
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Erste Schritte 
 

Installation und Registrierung von Amberlight 
 

 

Download & Installieren 

 

Nach Erwerb von Amberlight auf unserer Website erhalten Sie eine E-Mail mit dem Download-

Link und Ihren Registrierungsdetails. 

 

Mac OS X User 

Downloaden Sie die .dmg Datei mit dem Link in der Registrierungs-E-Mail. Lokalisieren Sie die 

Amberlight Installalationsdatei "Amberlight 2.1.dmg". Doppelklicken Sie auf den Installer, um die 

Installation auszuführen. 

 

Windows User 

Downloaden Sie die .zip Datei mit dem Link in der Registrierungs-E-Mail. Suchen Sie die 

Amberlight Installalationsdatei "Amberlight 2.1.zip". Extrahieren Sie den .zip-Ordner und 

doppelklicken Sie auf den .exe-Installer, um die Installation auszuführen. 

 

 

Registrieren 

 

Füllen Sie Ihre Registrierungsdetails gemäß Ihrer Registrierungs-E-Mail aus. Bitte überprüfen Sie, 

dass Sie mit dem Internet verbunden sind. Die Internetverbindung ist für die Aktivierung 

erforderlich, um Ihre Registrierungsdetails zu prüfen. 

 

 

TIPP: Wir empfehlen, Ihren Registrierungsschlüssel und ID per Copy & Paste einzufügen, um 

Rechtschreibfehler zu vermeiden und vice versa. 

 

 

 

Der erste Programmstart 

 

Beim ersten Start oder Programmupdates auf eine neuere Version sehen Sie ein Einfüh-

rungstutorial. Dieses Tutorial wird Sie durch die wichtigsten Amberlight Funktionen leiten. Sie 

können das Einführungstutorial auch jederzeit vom Menü -> Help starten. 
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Systemanforderungen 

 

Intel oder äquivalent AMD, OpenGL 2.0 Grafikkarte, 1GB RAM, 40 MB Festplattenspeicher, 

Windows XP, Vista, 7, 8, 10, oder Mac OS X 10.6 und neuer. 

 

 

Support für Amberlight 

 

Wenn Sie Hilfe bei der Verwendung von Amberlight benötigen, ziehen Sie bitte das enthaltene 

Hilfemanual zu Rate. Wir haben versucht, es einfach zu halten und alle erforderlichen 

Informationen zu umfassen. 

 

Gerne können Sie uns eine E-Mail senden an support@escapemotions.com bei Fragen, 

technischen Problemen oder wenn Sie uns grüßen möchten. 

 

Bevor Sie eine Frage stellen, lesen Sie bitte die FAQ auf unserer Website 

http://amberlight.escapemotions.com. Finden Sie dort keine Antwort, fügen Sie bitte Ihre 

Computerkonfiguration Ihrer E-Mail bei (Windows / Mac OS, 32/64bit OS, Prozessor, Grafikkarte, 

Speicher). Dies hilft uns, Antworten schneller zu finden. 

 

 

Community 

 

Bleiben Sie mit uns in Verbindung über unsere Social Media-Kanäle - klicken Sie auf 

untenstehende Icons und besuchen Sie unsere Seiten auf Facebook, Twitter, Pinterest, Google+, 

Tumblr, YouTube, DeviantArt, Behance und Instagram. 

 
0 

 

 
 

  

mailto:support@escapemotions.com
https://www.instagram.com/escapemotions
https://www.facebook.com/flamepainterpage?ref=hl
https://www.behance.net/escapemotions
http://escmot.deviantart.com/
https://www.youtube.com/user/EscapeMotions
https://www.tumblr.com/blog/escapemotions/
https://plus.google.com/u/1/b/109066869359827919028/109066869359827919028/posts
http://www.pinterest.com/escapemotions/
https://twitter.com/escapemotions
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Benutzeroberfläche 
 

 
 

1 - Viewport / Ansichtsfenster 
2 - Scene Panel / Szene-Fenster 
3 - Parameters Panel / Parameter-Fenster 
4 - Modifiers Panel / Modifikatoren-Fenster 
5 - Contrast Curve Panel / Kontrastkurve-Fenster 
6 - Filter Panel / Filter-Fenster 
7 - Navigator Panel / Navigationsfenster 
8 - Palette Panel / Palette-Fenster 
9 - Layers Panel / Ebenenfenster 
10 - Timeline / Zeitleiste 
 
 
Dies ist eine Standardbenutzeroberfläche von Amberlight. Sie können sie nach Ihren 
Bedürfnissen ändern. 
 
TIPP: Alle Fenster sind andockbar – Sie können deren Positionen verschieben und die Größen 
ändern. 
  



8 
 

Scene Panel / Szene-Fenster 
 

Fields / Felder - Felder-Zahl Einstellung (1-12) 

 /   - Markierte Felder hinzufügen oder entfernen. 

 Edit / Bearbeiten - In den Bearbeitungsfeldmodus 
wechseln.  

 Random / Regellos - Zufällige Szene und Felder. 
 

 Render / Rendern - Aktuelle Frames rendern.  

 Render animation / Animation rendern - Die Vorschau 
der Animation rendern. 
Step / Schritt - Die Anzahl den Render-Schritten – 
Iterationen stellen. Wenn Sie glatt gerenderte Szene haben 
möchten, stellen Sie es auf 10000. Wenn Sie eine 
Druckqualität benötigen, soll eine höhere Anzahl gesetzt 
werden.  

 Use actual value / Aktuellen Wert benutzen - Den 
Wert aus Schritt als Endwert verwenden.  
Raster - Rasterwert auswählen (1-8). Setzen Sie Raster auf 
höhere Werte für Vorschau-Zwecke, das Rendering wird 
schneller sein. 

 
 

Parameters Panel / Parameter-Fenster 
 

Position X - Die Position X des Feldes stellen. 
Position Y - Die Position Y des Feldes stellen. 
Force / Kraft- Die Kraft des Feldes stellen. 
Intensity / Intensität - Die Intensität des Feldes stellen. 
Cut-off / Ausschnitt - Setzen Sie den Ausschnitt des Feldes. 
 
 
 
 
 
 

Mehr über Feldparameter und wie man sie bearbeiten kann, finden Sie im Kapitel 'Edit Fields / 
Feldbearbeitung’.  
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Modifiers Panel / Modifikatoren-Fenster 
 
Experimentieren Sie mit Feld-Modifikatoren und manipulieren Sie das endgültige Aussehen. 

Modifikatoren unterteilen sich in: 

 

Variations / Variationen 

 

Es gibt zwei Arten von Variationen zur Auswahl: 
Random / Regellos – die Felder werden zufällige Formen 
und Formationen erstellen. 
Uniform – die Felder werden einheitliche Formen und 
Formationen erstellen. 
 
Number / Anzahl - Wählen Sie die Anzahl der Variationen 
(1-50). Die Anzahl beeinflusst, wie viele Variationen auf der 
Szene erstellt werden. 
 
Scale / Skala - Skalieren Sie die Variationen (1-100). Doe 
Skala beeinflusst die Position jeder Variation. Wenn die 
Skala niedriger ist, werden die Variationen einander näher 
gerendert. Wenn die Skala höher ist, werden Variationen 
weiter voneinander gerendert. 
 

 

Wave / Welle 
 

Wave / Welle ist ein Modifikator, der den letzten Look 
beeinflusst. Es gibt sechs verschiedene Arten von 
Wellenmodifikatoren zur Auswahl: 
None / Keine - Kein Wellenmodifikator wird verwendet. 
Circle / Kreis - Kreiswelle. 
Square / Quadrat - Quadratische Welle. 
Vertical / Vertikal - Vertikale Welle. 
Horizontal - Horizontale Welle. 
 
Frequency / Frequenz - Stellen Sie die Geschwindigkeit, 
mit der die Wellen auf der Szene wiederholt werden (1-
100). 
 
Amplitude - Die Amplitude der Welle (1-100) stellen. Die 
Amplitude ist der halbe Abstand zwischen den minimalen 
und maximalen Werten der Welle. 
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Contrast Curve / Kontrastkurve 
 

Es gibt drei verschiedene Kontrasteinstellungen: 
 
Base / Basis - Stellt die Basis der Kontrastkurve - Schatten.  
Peak / Spitz - Stellt die Spitzen der Kurve - Highlights.  
Limit / Höhepunkt - Stellt den Grenzwert der Kurve - 
Höhepunkt. 

 
 

Filter / Filter-Fenster 
 

Dies sind die Filterparameter für Sie zu experimentieren: 
 
Alpha Mask - Bild-Opazität von Amberlight (0 - 100). 

Tint - Farbverlauffilter ein- und ausschalten, drehen und 

stellt den Farbton und Radius (0 - 100) 

Glow - Leuchteffekt ein- und ausschalten 

 Radius - den Radiusschein stellen (0 - 100) 

 Strength / Stärke - die Scheinstärke stellen (0 - 100) 

 

 

Navigator Panel / Navigationsfenster 
 

 Zoom Out / Rauszoomen - aus dem Bild 
herauszoomen (bis 5%). 

 Zoom In / Einzoomen - in das Bild reinzoomen (bis 
2000%). 
Zoom Slider / Zoom-Schieberegler - Den Zoom mit dem 

Zoom-Schieberegler (1 - 2000%) stellen. 

 Reset Zoom / Zoomfaktor zurücksetzen - Bitte 
Zoomwert überprüfen. Beim Click auf diesem Button wird 
auf 100% gezoomt. 

 Fit to screen / An Bildschirm anpassen - Passt die Szene 

der Bildschirmgröße an. 
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Palette Panel / Palette-Fenster 
 

Wählen sie einen Farbverlauf und klicken Sie auf die zu 
ändernde Farbe unterhalb des Farbverlaufs. Einzelne 
Farben des Verlaufs können ein- bzw. ausgeschaltet 
werden. 
 

 Palette - Systemfarbpalette öffnet sich.  

 Gradient to White - Farbverlauf zur weißen Farbe 

ändern.  

 Gradient to Black - Farbverlauf zur schwarzen Farbe 

ändern. 

 

 Flip - Verlaufsübergang spiegeln 

 Invert - Farben in Farbverlauf invertieren 

 Shift - Farbverlauf nach rechts verschieben 

 

H | S | L - Farbton | Farbsättigung | Helligkeit - Farbton, 

Sättigung und Helligkeit aller Farben im Verlauf ändern. 

 

 

 

 

 

Palette – Farbe wählen. 

Color set / Farbset - Standardsatz von verwendeten Farben. Sie können benutzerdefinierte 

Farben hinzufügen - diese werden für zukünftige Malprojekte gespeichert, auch wenn das 

Programm geschlossen wird. 

 /   - Farben zum Farbset hinzufügen bzw. entfernen. 

 

Gradients /Farbverläufe - Farbverlauf aus der Farbverlaubsliste wählen.  

 /   - Farbverläufe hinzufügen bzw. entfernen. 

 

Um eine monochromatische Farbe anstelle eines 

Farbverlaufs zu verwenden, setzen Sie die erste Farbe des 

Farbverlaufs auf Schwarz, die Mitte auf die Farbe, die Sie 

verwenden möchten, und die letzte Farbe auf Weiß. 
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Layers Panel / Ebenenfenster 

 
Mit dem Ebenenfenster man kann die Ebene bearbeiten 
and mit den Einstellungen manipulieren. 
 
Blending - Ebenenmodus. 
Opacity - Deckkraft der Ebene (0 - 100). 

 Eye / Augenicon - Ebene sichtbar oder unsichtbar 
machen.  
Background Color / Hintergrundfarbe - Hintergrundfarbe 
verstecken oder zeigen und Farbton wählen. 
 
Um eine Szene mit transparentem Hintergrund zu 
speichern, verstecken Sie die Hintergrundfarbe (das 
Augenicon klicken) und als .png speichern können.  

 Import Image / Bild importieren - Das zweite Bild für 
Komposition importieren.  

 Clear Layer / Ebene leeren - Ebeneninhalt 
(Amberlight oder Image) leeren. 

 
 

Timeline Panel / Zeitleiste 
 
Verwenden Sie die Zeitleiste, um Animationen zu erstellen, zu bearbeiten und Frames und Keys 

zu manipulieren. 

 

 
 

Playback Range Start Time / Startzeit des Wiedergabebereichs - Stellen Sie die Startzeit des 

Wiedergabebereichs ein. Sie können es ändern, indem Sie eine neue Startzeit eingeben. Wenn 

Sie einen Wert eingeben, der größer als die Endzeit des Wiedergabebereichs ist, wird die 

Startzeit des Wiedergabereichs um eine Einheit weniger als die Endzeit des Wiedergabebereichs 

verschoben. 
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Playback Range End Time / Endzeit des Wiedergabebereichs - Stellen Sie die Endzeit des 

Wiedergabebereichs ein. Sie können es ändern, indem Sie eine neue Endzeit eingeben. Wenn 

Sie einen Wert eingeben, die kleiner ist als die Startzeit ist, wird die Endzeit zu einer Einheit mehr 

als die Startzeit des Wiedergabebereichs verschoben. 

Animation Start Time / Animation Startzeit - Stellen Sie die Nummer des ersten Frames in der 

Animation. 

Animation End Time / Animation Endzeit - Stellen Sie die Nummer des letzten Frames in der 

Animation. 

 

Current Frame / Aktuelles Frame - Das Eingabefeld zeigt das aktuelles Frame. Sie können das 

aktuelles Frame ändern, indem Sie einen neuen Wert eingeben. 

Range Slider / Bereich-Schieberegler- Stellen Sie den Wiedergabebereich. 

Time Slider / Zeit-Schieberegler - Steuern Sie den Wiedergabebereich, Keys und Auswahl im 

Wiedergabebereich. 

Rendered Range / Gerendertes Bereich - Eine grüne Linie zeigt die Frames, die schon mit der 

‘Render Animation’-Funktion gerendert wurden. 

Selection / Auswahl - Wählen Sie mehrere Keys zu kopieren, ausschneiden, einfügen oder 

löschen. 

 

Playback-Bedienelemente: 

 Go to Start / Auf Start - Gehen Sie auf die Startzeit des Wiedergabebereichs 

 Previous Keyframe/ Vorheriges Keyframe – Gehen Sie zum vorherigen Keyframe. 

 Previous Frame / Vorheriges Frame – Gehen Sie zum vorherigen Frame. 

 Play / Abspielen – Animation abspielen. Wenn die Animation abgespielt wird, wechselt das 

Button auf dem Stopp-Button  . 

 Next Frame / Nächstes Frame - Zum nächsten Frame gehen. 

 Next Keyframe / Nächstes Keyframe - Zum nächsten Keyframe gehen. 

 Go to End / Zu Ende- Zur Endzeit des Wiedergabebereichs gehen. 

 

 Add Keyframe / Keyframe hinzufügen - Neues Keyframe hinzufügen. 

 Remove Keyframe / Keyframe entfernen - ausgewählte Keyframe oder Keyframes 

entfernen. 

Auto Key / Auto Key - Automatisches Keyframing. Das Key wird automatisch auf dem aktuellen 

Frame erstellt. Schalten Sie aus, wenn Sie die Keys manuell einstellen möchten. 

All Fields / Alle Felder - Alle Felder schlüsselrahmen. Die Keys werden für alle Felder erstellt. 

Schalten Sie aus, wenn Sie nur ein ausgewähltes Feld markieren möchten. 

 Scene Settings / Szeneneinstellungen - Dialogfeld "Szeneneinstellungen" öffnet sich. 
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Edit Fields / Feldbearbeitung 
 

Drücken Sie Edit-Taste im Szenepanel oder linke Maustaste auf der Leinwand, um Felder zu 
bearbeiten. Sie können das Zahl der Felder im Szenepanel von 1 bis 12 einstellen. Jedes Feld 
wird als ein Kreis mit Position und 3 Parameter repräsentiert. Mit diesen Parametern können 
Sie einstellen, wie die Felder die Partikel beeinflussen werden. 
 

Feldparameter 
 

Center Position - (A) - Drücken Sie die linke 
Maustaste auf der Mittel Kreis-Taste und 
positionieren Sie das Feld auf der Szene. 
  
Force / Radius des Kraftfeldes - (B) - Drücken Sie 
die linke Maustaste und stellen Sie die Kraft des 
Feldes mit der Bewegung links oder rechts. Rechts 
von der Mitte hat das Feld die positive Kraft (+), 
links von der Mitte hat es negative Kraft (-). 
 
Intensity / Intensität - (C) - Drücken Sie die linke 
Maustaste und stellen Sie die Feldintensität mit 
der Bewegung nach oben und unten. Entfernung 
von der Mitte setzt den Intensitätswert. Nach oben 
ist es höher, nach unten von der Mitte ist es 
niedriger. Mit diesem Parameter beeinflussen Sie, 
wie intensiv der Einfluss des Feldes auf die Partikel 
ist.  
 
Cut-off / Ausschnitt - (D) - Drücken Sie die linke 
Maustaste und stellen Sie den Ausschnitt mit der 
Bewegung nach oben und unten. Entfernung von 
der Mitte stellt, wo die durchfliegenden Partikel 
vor dem Kraftfeld stoppen. 
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Arbeiten mit Feldern 
 

Um die Eigenschaften des ausgewählten Feldes zu kopieren, verwenden Sie Strg + C / Cmd + C 

oder Edit -> Copy Field Properties / Bearbeiten -> Feldeigenschaften kopieren. 

Um die Eigenschaften des ausgewählten Feldes zu einfügen, verwenden Sie Strg + V / Cmd + V 

oder Edit -> Paste Field Properties / Bearbeiten -> Feldeigenschaften einfügen. 

Um ausgewähltes Feld oder Felder zu duplizieren, verwenden Sie Strg + D / Cmd + D oder Edit -

> Duplicate Fields / Bearbeiten -> Felder duplizieren. 

Wählen Sie alle Felder mit Strg + A / Cmd + A oder Edit -> Select All Fields / Bearbeiten -> Wählen 

Sie alle Felder. 

Sie können auch Felder durch Klicken und Ziehen auswählen, um ausgewählte Felder zu 

verschieben, zu skalieren oder zu drehen.  

Verwenden Sie die Shift /Umschalttaste, um die Felder nur zu schwenken und Control 

/Steuerung/ Cmd um die Felder nur zu drehen. 

Der Mittelpunkt der Drehung wird als (+) Symbol angezeigt. Sie können durch Klicken und Ziehen 

(+) in der gewünschten Position in die Mitte irgendwo auf der Szene platzieren. 

 

 
 

Sie können die Raster über das Menü Scene -> Snap to Grid / Szene -> Am Raster ausrichten 

ansehen, um die Felder genauer zu positionieren. Der Mittelpunkt des Feldes, Auswahl und 

Keyframes sind an Raster aufgerichtet. 

Sie können die Anzahl der Raster im Preferences Panel / Einstellungsfenster festlegen.  
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Die Menüleiste 
 
File / Datei - enthält Elemente im Zusammenhang mit Laden, Speichern, Exportieren und 
Veröffentlichen Ihrer Bilder. 
Edit / Bearbeiten - enthält Elemente im Zusammenhang mit Werkzeuge- und 
Felderbearbeitung.  
Scene / Szene - enthält Elemente im Zusammenhang mit Bearbeitungswerkzeuge, Szene und 
Render-Funktionen. 
Filter - enthält Elemente im Zusammenhang mit Bildfiltern. 
View / Ansicht - enthält Elemente im Zusammenhang mit dem Ansichtsfenster. 
Windows / Fenster - enthält Elemente im Zusammenhang mit der Benutzeroberfläche. 
Help / Hilfe - enthält Elemente mit welchen Sie die Anwendungshilfe bekommen, neue 
Updates auf die Webseite. 
 

 

File Menu / Datei 
 

Das Datei-Menü enthält Elemente im Zusammenhang mit Ihre Szene. Die Funktionen sind wie 

folgt: 

New... / Neu… - Erzeugt ein neues Bild mit neuen Einstellungen. Sie können die Breite und Höhe 

der neuen Szene in Pixel, Zentimeter oder Zoll einstellen, die Wiedergabegeschwindigkeit in 

Frames pro Sekunde (FPS) einstellen, Playback-Looping, Hintergrundfarbe und Bild DPI 

auswählen: 
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Sie können auch aus einer Vielzahl vorgegebener Szenegrößen auswählen oder Vorgaben hinzufügen 

/ entfernen durch Klick auf die  /   Buttons.  

 

Open... / Öffnen… - Öffnen Sie das Dialog zum Öffnen eine Szene von der Festplatte. 

Open recent… / Zuletzt geöffnet - Eine der zuletzt gespeicherten Kunstwerke öffnen. 
Save... / Speichern… - Speichern Sie die aktuelle Szene in .amb, .png, .jpg, .bmp und .tif 
Dateiformat. Wurde die Szene noch nicht gespeichert, wird nach einem neuen Namen gefragt. 
Save As… / Speichern unter… - Speichern Sie die aktuelle Szene mit einem neuen Dateinamen. 
 
Import Image... / Bild importieren… - Importieren Sie die Bilder in .png, .jpg, .bmp und .tif 

Format nach Image layer. Es wird in der Größe verändert die zur tatsächliche Leinwandgröße 

passt. Sie können es auf jede Größe ändern. Drücken Sie Enter / die Eingabetaste, um zu 

bestätigen oder Esc, um abzubrechen. 

Export Image… / Bild exportieren… - Exportieren Sie die Bilder in .png, .jpg, .bmp und .tif Format 

von Amberlight.  

 

Publish Image... / Bild veröffentlichen... - Veröffentlichen Sie Ihr Bild zur Escape Motions 

Galerie. 
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Publish Preferences... / Voreinstellungen veröffentlichen… - Ein Untermenü enthält Galerie-

Einstellungen Geben Sie Ihren Namen, E-Mail (“Your ID”) und Passwort ein. Optional ist die 

Angabe Ihrer eigenen Webseite. 

 

Siehe auch Kapitel 'Veröffentlichen eigener Werke in der Online-Galerie'. 

 

Preferences… / Voreinstellungen... - Setzt General und Tastatur Voreinstellungen.  

- General  

- Startup Screen / Startbildschirm - Öffnet den Neue Szene-Dialog bei Programmstart. Aktivieren 

Sie diese Option, wenn Sie möchten, dass sich der Neues Kunstwerk-Dialog bei 

jedem Programmstart öffnet.  

- Scene - Zoom at cursor. / Szene - Zoom am Cursor. Aktivieren Sie diese Option, wenn Sie vom 

Cursor aus zoomen möchten, nicht von der Mitte der Szene. 

- Jpeg compression / Kompression - Bestimmt die Qualität der JPEG-Datei. 

- Interface / Programmoberfläche skalieren - Verändert die Größe der Programmdarstellung (90-

200%). 

- Spinbox editing sensitivity / Emfindlichkeit des Bearbeitungsfelds - Legen Sie die 

Empfindlichkeit der Spinbox-Bearbeitung für Maus oder Tablet fest. 

- Memory / Speicher - Stellen Sie den maximal verwendeten Speicher ein. 

- Grid / Raster - Stellen Sie die Anzahl der horizontalen und vertikalen Gitterlinien ein (maximal 

100). 

- Keyboard / Tastatur  

Hier können Sie eigene Tastaturkürzel (Shortcuts) festlegen. Klicken Sie auf "Wiederherstellen", 

um den aktuellen Shortcut zurückzusetzen. Klicken Sie auf "Alles wiederherstellen", um alle 

Shortcuts zurückzusetzen. 

 

Abschließend klicken Sie OK zum Bestätigen oder Cancel / Abbrechen zum Abbruch der 

Änderungen. 

 

Quit / Beenden - Programm schließen. (Nur für Windows) 
 

Siehe auch Kapitel 'Erzeugen, Öffnen und Speichern von Szenen'. 
 

TIPP: Auch können Sie ein Bild ziehen und ablegen (Drag and Drop Funktion) aus anderen 
Anwendungen, Ordnern oder Internet-browsern direkt nach Amberlight ziehen, wenn die 
Anwendung es erlaubt.  
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Edit Menu / Bearbeiten-Menü 
 

Undo / Rückgängig - Letzten Schritt rückgängig machen. Die maximale Anzahl an Rückgängig-

Schritten beträgt entweder 100. 

Redo / Wiederholen - Letzten Schritt wiederholen. 

 

Copy Field Properties / Feldeigenschaften kopieren - Die Eigenschaften des ausgewählten 

Feldes kopieren. 

Paste Field Properties /Feldeigenschaften einfügen - Die Eigenschaften des ausgewählten 

Feldes einfügen. 

Duplicate Fields / Felder duplizieren - Ausgewähltes Feld oder Felder duplizieren. 

 

Select All Fields / Alle Felder wählen - Alle Felder wählen. 

 

 

Scene Menu / Szene-Menü 
 
Scene Settings… / Szenevoreinstellungen… - Ein neuer Dialog öffnet sich. Sie können die 
Szenegröße einstellen. Sie können wählen, ob Sie das Seitenverhältnis der Szene halten wollen 
(Keep aspect ratio) oder ob Sie die Felder skalieren (Scale fields) möchten. 
 
Edit / Bearbeiten - Feld-, Position- und Paramenterbearbeitung (Kraft, Intensität und 
Ausschnitt)  
Edit Trajectory / Trajektorie bearbeiten - Die Keys und Animationstrajektorie-Tangenten 

bearbeiten. Jedes Key hat zwei Tangenten, links und rechts. Bewegliche Tangenten eines Keys 

ändern die Form der Animationstrajektorie. 

Reset Tangents / Tangenten zurücksetzen - Tangenten auf Standard zurücksetzen. 

 

Random / Regellos - Zufällige Szenen und Felder. 

 
Snap to Grid / Am Raster ausrichten - Verwenden Sie das Raster, um die Felder genauer zu 
positionieren. Sie können die Anzahl der Raster im Einstellungsfenster einstellen. 
Crop / Freistellen - Wählen Sie den Bereich zum Freistellen aus. Der freigestellte Bereich wird 

auf die Szene gelegt und die Felder werden entsprechend skaliert. 

 

Render Image / Bild rendern - Aktuelles Frame rendern. 

Render Animation / Animation rendern - Animation rendern, um eine Vorschau anzeigen, wie 

die endgültige Rendering aussehen wird.  

Final Render / Endgültige Rendering - Die endgültige Animation rendern und auf dem 
Computer speichern. Wählen Sie den Pfad, den Dateinamen und das Dateiformat aus- 
entweder als Bildsequenz im .jpg, .png, .bmp, .tif oder als Video im .mov oder .mkv-
Dateiformat.  
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Filter Menu / Filter-Menü 

 
Tint - Tint Filter ein- und ausschalten. Stellen Sie den Farbton und Radius im Szene-Panel.  
Glow - Leuchteffektfilter ein- und ausschalten. Stellen Sie den Radius und Kraft im Szene-Panel. 

Tile / Kachel - Kachelt die Ebene (horizontal und vertikal) für repetitive Bilder. 
 

 

View Menu / Ansicht 
 

Zoom In / Einzoomen - in das Bild reinzoomen (bis 800%). 
Zoom Out / Rauszoomen - aus dem Bild herauszoomen (bis 5%) 
Zoom 100% - Bitte Zoomwert überprüfen. Beim Click auf diesem Button wird auf 100% 
gezoomt. 
Fit to Screen / An Bildschirm anpassen - Passt die Szene dem Bildschirm an. 

 

Stay on Top / Bleib auf der Spitze - Die Applikation bleibt immer auf der Spitze der anderen 
Applikationen. 
Enter Full Screen / Vollbild - Stellt auf volle Bildschirmgröße um.  

 

 

Window Menu / Fenster-Menü 
 
Das Fenster-Menü enthält Elemente im Zusammenhang mit dem Ansichtsfenster und 
Benutzeroberfläche. 
 
Scene / Szene - Szene-Fenster zeigen oder verstecken. 
Parameters / Parameter - Parameter-Fenster zeigen oder verstecken. 

Modifiers / Modifikatoren - Modifikatoren-Fenster zeigen oder verstecken. 

Contrast Curve / Kontrastkurve - Kontrastkurve-Fenster zeigen oder verstecken. 

Filter - Filter-Fenster zeigen oder verstecken. 

Navigator - Navigationsfenster a zeigen oder verstecken. 

Palette / Palette – Palette-Fenster zeigen oder verstecken. 
Layers / Ebenen - Ebenenfenster zeigen oder verstecken. 
Timeline / Zeitleiste - Zeitleiste zeigen oder verstecken. 

 

Deaktivieren Sie das Werkzeugfenster, um es von der Benutzeroberfläche zu verbergen. 
Aktivieren Sie das Werkzeugfenster, um es zur Benutzeroberfläche zu bringen. 
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Help Menu / Hilfe 
 
Help / Hilfe - Öffnet dieses Dokument (in Englisch) 
Send Feedback... / Feedback senden... - Schicken Sie uns Ihr Feedback - wenn Sie irgendwelche 

Probleme oder Ideen haben oder das Programm Ihnen gefällt. Sie können zwischen drei 

Feedback-Arten wählen: 

Bravo - Wollen Sie uns mitteilen, wie cool Amberlight ist? 

Idea / Idee - Haben Sie Ideen für neue Features, die eine großartige Ergänzung für 

Amberlightwären? 

Bug / Fehler - Haben Sie Probleme bei der Nutzung von Amberlight festgestellt? 

 

Tragen Sie Ihre E-Mail-Adresse ein und schreiben uns eine Nachricht - wir lesen jede einzelne. ☺ 

 
Amberlight Website - Link zur Webseite: http://amberlight.escapemotions.com 
About Amberlight / Über Amberlight - Informationen über Amberlight, Copyright und 
Danksagungen. (In Help Menü nur für Windows.) 
Show Library Folder / „Library“-Ordner zeigen - Den Ordner zeigen wo die Farbverläufe 
gespeichert sind. 
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Animation 
 

Diese Kapitel beschreibt, wie Sie Animationen in Amberlight erstellen können: 

 

1. Neue Szene erstellen 

2. Wiedergabegeschwindigkeit und Wiedergabewiederholung einstellen 

3. Arbeiten mit Zeitleiste 

4. Felder animieren (einfaches Beispiel)  

5. Experimentieren mit Modifikatoren 

6. Animation Vorschau 

7. Endgültige Rendering 

 

1. Neue Szene erstellen 
 

In diesem Kapitel beschreibt man, wie Sie die neue Szene erstellen in Amberlight können: 

 

1. Klicken Sie File / Datei-> New… / Neu… und a Dialogfeld "New Scene / Neue Szene" öffnet sich: 
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2. Stellen Sie die Breite, Höhe und DPI der Szene manuell oder wählen Sie aus den Szenengrößen 

und Vorgaben. 

3. Stellen Sie die Wiedergabegeschwindigkeit in FPS ein und aktivieren / deaktivieren Sie die 

Wiedergabewiederholung (mehr über die Wiedergabegeschwindigkeit und die 

Wiedergabewiederholung im folgenden Kapitel). 

4. Speichern Sie die Einstellungen Ihrer benutzerdefinierten Szene für den Zukunftsbezug mit 

dem  Button. 

5. Stellen Sie die Hintergrundfarbe ein. Wählen Sie aus Schwarz, Weiß oder Transparent (Keine) 

oder wählen Sie Ihre eigene benutzerdefinierte Farbe aus der System-Farbpalette. 

6. Bestätigen Sie die Eingaben mit OK oder verwerfen diese mit Cancel / Abbrechen. 
 

Sie können diese Einstellungen jederzeit während der Arbeit an der Animation aus dem Menü 

Scene / Szene -> Scene Settings / Szeneneinstellungen oder direkt aus der Zeitleiste ändern, 

indem Sie auf das Szeneneinstellungenbutton   klicken. 

 

 

2. Wiedergabegeschwindigkeit und Wiedergabewiederholung 
 

Beim Erstellen einer neuen Szene können Sie ganz einfach FPS-Werte und 

Wiedergabewiederholung einstellen. FPS bezieht sich auf Frames pro Sekunde oder wie viele 

Frames für jede Sekunde gezeichnet werden müssen, die in Echtzeit vergeht. Diese Funktion ist 

wichtig, wenn man bedenkt, wie lang das endgültige Video sein sollte. Die empfohlene FPS-

Einstellung liegt zwischen 25-30 fps, aber das hängt davon ab, welchen Zweck das Video 

verwendet wird. Setzen Sie die Wiedergabewiederholung, wenn Sie ein kontinuierliches, 

wiederholtes Video-Ergebnis erstellen möchten. 

Sie können die Wiedergabegeschwindigkeit und die Wiedergabewiederholung ändern, bevor Sie 

für die Endgültige Rendering entscheiden. 

 

TIPP: Um zu zählen, wie viele Frames Sie für Ihr Video benötigen, denken Sie an Ihre endgültige 

Video-Länge in Frames pro Sekunde. Wenn Sie die Wiedergabegeschwindigkeit auf 30 FPS 

einstellen und das Video 30 Sekunden lang benötigen, müssen Sie 900 Frames erstellen (30 FPS x 

30 Sekunden). 
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3. Arbeiten mit Zeitleiste 
 

Verwenden Sie die Zeitleiste, um Animationen zu erstellen, zu bearbeiten und Frames und Keys 

zu manipulieren. 

 

 
 

Stellen Sie die Anzahl der Frames indem Sie die Animation Startzeit und Animation Endzeit 

setzen. Stellen Sie manuell die Startzeit des Wiedergabebereichs und Endzeit des 

Wiedergabebereichs. Klicken und ziehen Sie den Bereich-Schieberegler, um die Zeitleiste zu 

bewegen. Der Zeit-Schieberegler zeigt den Wiedergabebereich und die Keys an, die Sie für die 

ausgewählten Frames eingestellt haben. 

 

Die Playback-Bedienelemente steuern die Animationswiedergabe. Sie können die 

herkömmlichen Tasten zum Abspielen und Zurückspulen (zur Startzeit zurückkehren) erkennen. 

Die Stopp-Button erscheint nur, wenn die Animation abgespielt wird. Um herauszufinden, 

welche Operation das Button darstellt, halten Sie den Mauszeiger darüber: 

 

 Go to Start / Auf Start - Gehen Sie auf die Startzeit des Wiedergabebereichs 

 Previous Keyframe/ Vorheriges Keyframe – Gehen Sie zum vorherigen Keyframe. 

 Previous Frame / Vorheriges Frame – Gehen Sie zum vorherigen Frame. 

 Play / Abspielen – Animation abspielen. Wenn die Animation abgespielt wird, wechselt das 

Button auf dem Stopp-Button  . 

 Next Frame / Nächstes Frame - Zum nächsten Frame gehen. 

 Next Keyframe / Nächstes Keyframe - Zum nächsten Keyframe gehen. 

 Go to End / Zu Ende- Zur Endzeit des Wiedergabebereichs gehen. 

 

 Add Keyframe / Keyframe hinzufügen - Neues Keyframe hinzufügen. 

 Remove Keyframe / Keyframe entfernen - ausgewählte Keyframe oder Keyframes 

entfernen. 



25 
 

Auto Key / Auto Key - Automatisches Keyframing. Das Key wird automatisch auf dem aktuellen 

Frame erstellt. Schalten Sie aus, wenn Sie die Keys manuell einstellen möchten. 

All Fields / Alle Felder - Alle Felder schlüsselrahmen. Die Keys werden für alle Felder erstellt. 

Schalten Sie aus, wenn Sie nur ein ausgewähltes Feld markieren möchten. 

 Scene Settings / Szeneneinstellungen - Dialogfeld "Szeneneinstellungen" öffnet sich. 

 

Sie können mit einem ausgewählten Key oder 
Keys direkt in der Zeitleiste manipulieren. 
Verschieben Sie das Key mit Klick & Ziehen. 
Wählen Sie mehrere Keys gleichzeitig durch Klick 
& Ziehen oder mit der Umschalttaste. Bewegen 
Sie sie oder klicken Sie mit der rechten Maustaste 
auf die Auswahl und wählen Sie um das 
ausgewählte Key zu Copy / Kopieren, Cut / 
Ausschneiden, Paste / Einfügen oder Delete / 
Löschen. 
 

 
 

 

4. Felder animieren (einfaches Beispiel) 
 

Im Folgenden finden Sie ein Beispiel für eine einfache Animation. Wir erstellen Animation mit 

zwei Feldern. 

 

1. Stellen Sie die Startposition der Felder ein. Die 

Standardanzahl der Felder auf der Szene ist 4. 

Hinzufügen oder entfernen Sie einfach die Felder 

mit den  /  im Szene-Fenster oder geben Sie 

die genaue Nummer im "Fields / Felder" Bereich 

ein. Um Felder zu bearbeiten, klicken Sie 

entweder auf das "Edit / Bearbeiten-Button" im 

Szene-Fenster oder klicken Sie mit der linken 

Maustaste direkt auf die Szene. Sie können die 

Felder jederzeit während des Prozesses 

hinzufügen oder entfernen. Weitere Informationen zu Bearbeitung den Feldern finden Sie im 

Kapitel 'Edit Fields / Feldbearbeitung'. 
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2. Gehen Sie zum Frame 8 auf der Zeitleiste. 

 

 

 

 

 

 

 

 

 

3. Markieren Sie alle Felder mit Strg + A oder 

markieren Sie sie mit Multi-Selektion (klicken und 

ziehen).  

Verschieben Sie die Felder in die gewünschte 

Position.  

Wenn "Auto Key" eingeschaltet ist, wird das Key 

automatisch auf Frame 8 erstellt. 

 

 

 

4. Gehen Sie zum Frame 15 auf der Zeitleiste. 

 

 

 

 

 

 

 

 

 

5. Klicken Sie auf Feld 1 und verschieben Sie es in 

die gewünschte Position. 

Das Key für dieses Feld wird automatisch auf 

Frame 15 erstellt. 
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6. Klicken Sie auf Feld 2 und verschieben Sie es in 

die gewünschte Position.  

Das Key für dieses Feld wird automatisch auf 

Frame 15 erstellt. 

 

 

 

 

 

Um die Animationstrajektorie eines Feldes anzuzeigen, klicken Sie auf die Mitte des Feldes. 

Die Keys der Trajektorie werden als Knoten angezeigt. Sie können die Key-Position direkt auf der 

Kurve bearbeiten. 

 

Um die Keys und die Animationstrajektorie zu bearbeiten, gehen Sie zur Menüleiste: "Scene / 

Szene" -> "Edit trajectory / Trajektorie bearbeiten". Die Tangenten auf jedem Key erscheinen. 

Jedes Key hat zwei Tangenten, links und rechts. Das Verschieben von Tangenten eines Keys 

ändert die Form der Animationstrajektorie: 

 
 

Um die Tangenten auf den Standardwert zurückzusetzen, gehen Sie in das Menü: " Scene / 

Szene" -> " Reset tangents / Tangenten zurücksetzen". 

 

 

5. Experimentieren mit Modifikatoren 
 

Die Modifikatoren helfen Ihnen, das endgültige Aussehen der Szene zu gestalten und zu 

verändern. Sie sind in zwei Gruppen unterteilt: Variations / Variationen und Wave /Welle. 

 

Variations / Variationen 

Es gibt zwei Arten von Variationen zur Auswahl: 

Random / Regellos - Felder erzeugen zufällige Formen und Formationen. 

Uniform - Felder erzeugen einheitliche Formen und Formationen. 
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Sie können die Anzahl der Variationen auswählen, die sich auf die Anzahl der Variationen in der 

Szene auswirkt. Neben Variationen können Sie sie auch skalieren. Die Skalierung wirkt sich auf 

die Position jeder Variation aus: Wenn sie auf niedrige Werte eingestellt ist, werden die 

Variationen näher zueinander gerendert. Wenn die Skala höher ist, ist der Abstand zwischen den 

einzelnen Variationen größer. 

 

Beispiele für zufällige (Random) und einheitliche (Uniform) Variationen:

 
 

Wave / Welle 

Es gibt fünf verschiedene Arten von Wellen zur Auswahl: 

 

None / Keine - Es wird kein Wellenmodifikator verwendet. 

Circle / Kreis - Kreiswelle. 

Square / Quadratisch - Rechteckige Welle. 

Vertical / Vertikal - Vertikale Welle. 

Horizontal - Horizontale Welle. 

 

Beispiele für Wellenmodifikatortypen: 

 
 

Stellen Sie die Frequenz der Wellen ein, oder mit anderen Worten, die Rate, mit der Wellen auf 

der Szene wiederholt werden. Wählen Sie, wie stark die Wellen mit dem Amplitude-

Schieberegler sein sollen. Die Amplitude stellt die halbe Entfernung zwischen den Minimal- und 

Maximalwerten der Welle dar. 
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Beispiele für einen Quadratisch-Modifikator mit verschiedenen Frequenz- und 

Amplitudeneinstellungen: 

 

 

6. Animation Vorschau 
 

Um zu prüfen, wie die Animation tatsächlich aussieht, können Sie die Renderanimationstaste im 

Szenenbedienfeld verwenden. Sie müssen nicht die Animationsvorschau rendern, bevor Sie Final 

Rendering ausführen. Renderanimationstaste dient nur zu Vorschauzwecken. 

Wenn Raster auf 1 gesetzt ist, wird das Rendern glatter, das Bild wird von höherer Qualität sein, 

es dauert jedoch auch mehr Zeit, um die Animation zu rendern. Setzen Sie Raster auf 8, um mit 

geringer Qualitätsvorschau ein schnelleres Rendering zu erzielen. 

Frames, die in der Animationsvorschau bereits gerendert wurden, sind in der Zeitleiste grün 

markiert. 
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Hinweis: Das Rendering ist eine rechenintensive Operation. Wenn Sie viele Keys und Frames 

festgelegt haben, kann dies zeitaufwendig sein. Wir empfehlen Ihnen, Raster auf höhere Werte 

zu setzen, um das ungefähre Aussehen der Animation viel schneller zu erhalten. Die Qualität der 

Animationsvorschau entspricht nicht der Qualität des endgültigen Renderings. 

 

 

7. Endgültige Rendering 
 

Wenn Sie mit der Animation zufrieden sind, wählen Sie im Menü: Scene / Szene -> Final render 

/ Final-Rendern. 

Wählen Sie Pfad, Dateiname und Dateiformat - entweder als Bildsequenz in .jpg, .png, .bmp, .tif 

oder als Video im .avi, mov, .mkv oder .webm Format. 

 

 

Legen Sie für die Bildsequenz die Frameauffüllung 

(Frame # padding) und die Animationserweiterung 

(Animation extension) fest. 

 

Wählen Sie das Startframe, das Endframe und die 

Anzahl der Wiedergabeschritte. 

Klicken Sie auf Rendern, um das finale Rendern zu 

starten, oder auf Abbrechen (Cancel), wenn Sie dies 

nicht möchten. 

Klicken Sie auf Übernehmen (Apply), um die 

Änderungen zu übernehmen. 

 

Sie können Animationen aus der Bildsequenz mit 

Anwendungen von Drittanbietern erstellen. 
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Für Videos können Sie die Framerate in FPS 

einstellen. Wählen Sie den Codec für das 

Videoformat: 

.avi: h264, huffYUV (verlustfreie Komprimierung) 

.mov: h264, h265 

.mkv: h264, h265, huffYUV (verlustfreie Kompr.) 

.webm: VP8 

 

Wählen Sie zwischen grundlegenden (Basic) oder 

erweiterten (Advanced) Qualitätseinstellungen. 

Basic - Legen Sie die Qualität in% fest. Je höher 

die Qualität ist, desto größer wird die Datei sein. 

Advanced - Legen Sie die erweiterten 

Einstellungen für den ausgewählten Codec fest, 

einschließlich Profil, Pegel, Bitrate-Kodierung, 

Ziel- / maximale Bitrate und Keyframe-

Entfernung. 

Überprüfen Sie die verlustfreie Komprimierung, 

wenn das ursprüngliche und dekomprimierte 

Video identisch sein soll. Eine verlustfreie 

Komprimierungsoption ist für den VP8-Codec 

nicht verfügbar. 

Diese Einstellungen gelten für fortgeschrittene 

Benutzer, die mit H.264-, H.265- und VP8-Codecs vertraut sind. 

 

Wählen Sie das Startframe, das Endframe und die Anzahl der Wiedergabeschritte. 

Klicken Sie auf Rendern, um das finale Rendern zu starten, oder auf Abbrechen (Cancel), wenn 

Sie dies nicht möchten.  

Klicken Sie auf Übernehmen (Apply), um die Änderungen zu übernehmen. 

 

When the final render starts, the application calculates the estimated time of the render: 

 
Hinweis: Je mehr Schritte Sie für das endgültige Rendern festlegen, desto länger dauert es, bis die 

endgültige Animation wiedergegeben wird. Große Animationen können sogar einige Stunden 

dauern. Wir empfehlen Ihnen, solche Animationen zu rendern, wenn Sie Ihren Computer nicht 

aktiv benutzen, zum Beispiel während der Nacht.  
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Erzeugen, Öffnen und Speichern von Szenen 
 

Neue Szene erzeugen 

 

Mit STRG+N oder über den Menüpunkt File -> New… wird eine neue Szene zu erzeugt. Ein 
Dialogfenster erscheint, in welchem man die Bildgröße und weitere Einstellungen angeben kann. 
“Picture Size Info” gibt die Druckgröße des Bildes an. 
 

Sie können aus Szenengrößen und Vorgaben wählen und Ihre eigenen mit den  /  Buttons 
hinzufügen/ entfernen. 
 
Stellen Sie die Wiedergabegeschwindigkeit in FPS und Playback-Looping ein. 
 
Mit dem Farbbutton Custom... kann man die Hintergrundfarbe auswählen - Schwarz, Weiss und 
None (transparent). 
 
Bestätigen Sie die Eingaben mit OK oder verwerfen diese mit Cancel / Abbrechen. 
 
 

Szene öffnen 

 

Mit STRG+O oder über den Menüpunkt File -> Open... öffnet man ein Bild in .png, .jpg, .bmp, 
.tiff Dateiformate oder ein bestehendes Bild in Amberlight in .amb Dateiformat. Beim Öffnen 
eines vorher gespeicherten Kunstwerks, das Bild wird wieder neu gerendert werden. 
 
Öffnen Sie das Bild mit OK oder brechen Sie mit Cancel / Abbrechen ab. 
 
Um ein zuletzt gespeichertes Gemälde zu öffnen, wählen Sie die Open Recent / Zuletzt 

geöffnet Option im File / Datei-Menü. Diese Option lässt Sie eines der zuletzt gespeicherten 

Kunstwerke in .amb, .png, .jpg, .bmp and .tif Dateiformaten auswählen. 

 
 

Szene speichern 

 

Über die Menüpunkte File -> Save… speichert man das Bild auf die Festplatte. Amberlight nutzt 

ein eigenes Dateiformat mit der Endung AMB. In der Datei sind alle Informationen des Bildes 

und der Ebenen enthalten. Nutzen Sie dieses Dateiformat, wenn Sie später an einer bestehenden 

Szene weiterarbeiten möchten. Wenn Sie eine gespeicherte Szene später öffnen, wird die Szene 

wieder neu gerendert. Wir empfehlen Ihnen, Ihre Arbeit regelmäßig zu speichern, um Probleme 

zu vermeiden, während Sie sich an neue Software gewöhnen. 
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Wenn die Szene mit spezifischen Einstellungen oder für andere Programme lesbar 
abgespeichert werden sollen, nutzen Sie die Save As... Funktion über den Menüpunkt. Die 
Szene lässt sich in den Formaten .png, .tiff, .bmp oder .jpg abspeichern.  
 
Hinweis: Achten Sie darauf, dass nur .amb Datei alle Informationen des Bildes enthält. .png, .tiff 
und .bmp Dateien speichern nur die Farbe- und Transparenzinformationen. 
Transparenzinformationen werden nicht im .jpg-Format abgespeichert. 
 
 
 
Speichern Sie das Bild mit OK oder brechen Sie mit Cancel / Abbrechen ab. 
 

 

Programm schließen 
 
Wenn Sie die Anwendung schließen möchten, können Sie je nach Betriebssystem folgende Optionen 

wählen: 

 

Windows user  
- Klick auf File Menü -> Beenden oder  
- Klick auf Close Button im 
Programmfenster rechts oben oder  
- verwenden Sie den Shortcut Strg+W or 
Alt+F4  
 
 

Mac OS user  
- Klick auf das Amberlight Menü-> Beenden 
oder  
- Klick auf Quit Button im Programm-
Fenster links oben oder  
- verwenden Sie den Shortcut Cmd-Q in 
Mac OS  
 

 
Hinweis: Bitte vergessen Sie nicht, Ihr Bild VOR dem Programmschließen zu speichern.   
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Veröffentlichen eigener Werke in der Online-Galerie 
 
 

Galerie-Konto erzeugen 
 
Um eigene Werke zu veröffentlichen, ist ein eigenes Konto erforderlich. Anbei die Beschreibung 
zweier Vorgehensweisen:  
 
Aus Amberlight heraus: 
Konto über den Menüpunkt File -> Publish Preferences erzeugen. Geben Sie Ihren Namen, E-
Mail (“Your ID”) und Passwort ein. Optional ist die Angabe der eigenen Webseite. 
 
Auf der Webseite: 
Auf der Galerie Webseite loggen Sie sich über login -> Create Account ein und geben Ihre “Your 
ID” (Ihre Registrierungs-E-Mail) an. Sie erhalten per E-Mail ein Passwort zugeschickt. 
Bem.: "Your ID" wird im Programmmenü Help -> About Amberlight angezeigt. Sollte "Your ID" 
nicht existieren, geben Sie Ihre aktuelle E-Mail-Adresse ein. 
 
 

Veröffentlichen eigener Werke 
 
Um ein eigenes Werk in der Galerie zu veröffentlichen, nutzen Sie den Menüpunkt File -> 
Publish... Geben Sie Ihrem Werk einen Namen (Artwork Name), eine Bechreibung (Description) 
und Stichwörter (Tags). Durch das Klicken des Publish Buttons wird Ihr Bild auf der Escape 
Motions Gallery Webseite (www.escapemotions.com/gallery) veröffentlicht. Die Bilder dort 
können auch nachträglich weiter bearbeitet warden. 
 
 

Galerieprofil und Bilder bearbeiten 
 
Gehen Sie auf die Gallery website, loggen Sie sich über login ein und geben "Your ID" und 
Password an. 
Im Bereich Edit Pictures können u.a. Namen, Beschreibungen und Stichwörter bearbeitet 
werden. 
Im Bereich My Profile kann das Passwort geändert warden. 
 
Hinweis: Nur Bilder können in unsere Online-Galerie geschrieben werden. Wenn Sie ein Video 

teilen möchten, laden Sie es auf die Video-Sharing-Webseiten wie Youtube oder Vimeo.  

http://www.escapemotions.com/gallery
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Tastenkürzel: 
 
 
     Windows    Mac OS 
 
New... / Neu...    Strg-N     Cmd-N 
Open.../ Öffnen...   Strg-O     Cmd-O 
Save/ Speichern   Strg-S     Cmd-S 
Save As... / Speichern unter...  Strg-Shift-S    Cmd-Shift-S 
Quit / Beenden   Strg-W     Cmd-Q 
Import Image... /  
Bild importieren…   Strg-I     Cmd-I 
Publish image... /  
Bild veröffentlichen...   Strg-P     Cmd-P 
Preferences / Voreinstellungen Strg-,     Cmd-, 
 
Undo     Strg-Z     Cmd-Z 
Redo     Strg-Shift-Z    Cmd-Shift-Z 
    
Copy Field Properties /  
Feldeigenschaften kopieren  Strg-C     Cmd-C 
Paste Field Properties /  
Feldeigenschaften einfügen  Strg-V     Cmd-V 
Duplicate Fields / Felder duplizieren Strg-D     Cmd-D 
Select All Fields / Alle Felder wählen Strg-A     Cmd-A 
Delete Fields / Felder löschen  Del     Del 
 
Scene Settings... /  
Szenevoreinstellungen  Strg-E     Cmd-E 
 
Edit Mode / Bearbeitungsmodus E     E 
Ausgewählte Felder schwenken   Linke Maustaste   
Ausgewählte Felder skalieren  Shift + LMT    Shift + LMT 
Ausgewählte Felder drehen  Strg + LMT    Cmd + LMT 
 
Wert um 1 vergrößern  Pfeil nach oben   Pfeil nach oben  
Wert um 1 verringern   Pfeil nach unten   Pfeil nach unten 
Wert um 10 vergrößern  Pfeil nach oben   Pfeil nach oben 
Wert um 10 verringern  Pfeil nach unten   Pfeil nach unten 
 
Move Scene / Szene bewegen   Rechte Maustaste  
 
Previous Keyframe /  
Vorheriges Keyframe   Strg-Links    Cmd-Links 
Next Keyframe /  
Nächstes Keyframe   Strg-Recht    Cmd-Recht 
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Previous Frame / Vorheriges Frame Links     Links  
Next Frame / Nächstes Frame Recht     Recht 
Play | Stop / Abspielen | Stopp  Leertaste 
Add Keyframe / Keyframe hinzufügen    S     S 
Remove Keyframe /  
Keyframe entfernen   Del     Del 
 
Zoom In / Reinzoomen  Strg - +     Cmd - + 
Zoom Out / Rauszoomen  Strg - -     Cmd - - 
Zoom 100%    Strg - 0     Cmd - 0 
Zoom In | Out /  
Rein- und Rauszoomen   Mausrad oder Alt + Mausrad 
Fit to Screen /  
An Bildschirm anpassen  Strg-.     Cmd-. 
 
Help / Hilfe    F1     Cmd + ? 
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Copyright & Danksagungen 
 
 
Amberlight © 2013-2016 Escape Motions, s.r.o 
Amberlight © 2009-2012 Peter Blaškovič 
 
 

Amberlight Team: 
 
Peter Blaškovič, Michal Fapšo, Ľuboš Tóth, Miroslav Sedlák, Anton Poživenec, Veronika 
Klimeková, Andrea Hornáková, Jaroslav Kaša 
 

Unser besonderer Dank geht an: 
 
alle, die mit Ideen, Anregungen beigetragen und Amberlight finalisieren geholfen, insbesondere 
Mark Schafer, Shannon Hoppe, Casey Herbert, Tomáš Lancz and Rastislav Piovarči. 
Übersetzung und Korrekturen: Tanya Hayman, Veronika Klimeková, Marta Fernandez, Andrea 

Vachová, Irene Briz. 

User Interface Icons / Benutzeroberfläche Ikonen: "Batch" by Adam Whitcroft 
 
 

Libraries / Bibliotheken: 
 
Diese Applikation ist mit den folgenden Bibliotheken entwickelt worden: 
Qt 4.8 - LGPL license (2.1) - http://qt-project.org/downloads/ 
QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/ 
CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/ 
FFmpeg with libx264, libx265 and libvpx - https://www.ffmpeg.org/ 

H.264/AVC license by MPEGLA - http://www.mpegla.com 

H.265/HEVC license by MPEGLA - http://www.mpegla.com 

 
Eine vollständige Liste der Lizenzen ist im Installationsordner verfügbar: Amberlight 2/Licenses. 

 
 
Wir danken Gott für die vielen kreativen Ideen.  

http://qt-project.org/downloads
http://sourceforge.net/projects/quazip/
http://www.cryptopp.com/
https://www.ffmpeg.org/
http://www.mpegla.com/
http://www.mpegla.com/
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Amberlight End-User Software License Agreement  
 
 
Copyright © 2013-2016 Escape Motions, s.r.o. All Rights Reserved. 
Copyright © 2009-2013 Peter Blaškovič. All Rights Reserved. 
 
This license is a legal agreement between you and Escape Motions for the use of Amberlight 
software (the "Software"). By downloading, installing, copying, or otherwise using the Software, 
you acknowledge that you have read terms and conditions of this license, understand them, and 
agree to be bound by them. If you do not agree with these terms and conditions, Escape Motions 
is unwilling to license the Software to you, and you are not authorized and may not use the 
Software. 
 
 
Permitted Use  
 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
The Software may be installed on a computer that is for multiple users but it may not be installed 
on more than one computer regardless of whether those computers are operated 
simultaneously or not. 
Users may use the Software for commercial or for-profit activities as well as for personal, non-
commercial, or non-profit activities.  
 
You may not remove the copyrights notices from the Software. You may make one (1) copy of 
the Software for back-up or archival purposes. 
 
 
Restrictions  
 
This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law 
and international treaty.  This is a license, not a transfer of title, and unless you have been 
granted prior, written consent from Escape Motions you may not:  
a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.  
b, Sell, rent, lease, assign, or sublet the Software or portions thereof.  
c, Grant rights to any other person.  
d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the 
Software or the documentation in whole or in part.  
e, Use the Software in violation of any international law or regulation.  
 
You must not intentionally or unintentionally make the Software available on any web server, 
ftp server, file sharing network, shared directory, or other location where any other person can 
acquire a copy of the Software. You are responsible for keeping the Software safe from being 
copied by others. 
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Display of Copyright Notices  
 
All copyright and proprietary notices and logos within the Software files must remain intact.  
 
Indemnity  
 
You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or 
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your 
use or misuse of the Software, or a violation of any terms of this license.  
 
The Software may contain technical inaccuracies or typographical errors, so changes and/or 
updates may be affected without notice. Escape Motions may also make improvements and/or 
other changes to the Software at any time without notice.   
 
Disclaimer Of Warranty  
 
THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR 
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO, 
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE.  FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT 
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.  
 
H.264/AVC and H.265/HEVC License Notice 
 
To the extent that the Software contains AVC and HEVC encoding and/or decoding functionality, 
commercial use of AVC and HEVC requires additional licensing and the following provision 
applies: THE AVC AND HEVC FUNCTIONALITY IN THIS PRODUCT IS LICENSED HEREIN ONLY FOR 
THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO ENCODE VIDEO IN 
COMPLIANCE WITH THE AVC AND HEVC STANDARD ("AVC VIDEO" / “HEVC VIDEO”) AND/OR 
DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-
COMMERCIAL ACTIVITY AND/OR AVC AND HEVC VIDEO THAT WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC AND HEVC VIDEO. 
INFORMATION REGARDING OTHER USES AND LICENSES MAY BE OBTAINED FROM MPEG LA L.L.C. 
SEE HTTP://WWW.MPEGLA.COM. 
 
Limitations Of Liability  
 
YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR 
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH THE 
SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE 
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING BUT 
NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST 
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR 
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS. 


